
HP UFT Connection Agent
Software Version: For UFT 12.02
Macintosh ® operating systems

User Guide

Document Release Date: December 2014
Software Release Date: December 2014



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing
herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial
Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under
vendor's standard commercial license.

Copyright Notice
© Copyright 1992 - 2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Google™ and Google Maps™ are trademarks of Google Inc

Intel® and Pentium® are trademarks of Intel Corporation in the U.S. and other countries.

Microsoft®,Windows®,Windows® XP, and Windows Vista ® are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

Support
Visit the HP Software Support Online web site at:https://softwaresupport.hp.com

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools
needed to manage your business. As a valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
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l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP
Passport ID, go to:https://softwaresupport.hp.com and click Register.

To find more information about access levels, go to:https://softwaresupport.hp.com/web/softwaresupport/access-levels.

HP Software Solutions & Integrations and Best Practices
VisitHP Software Solutions Now athttps://h20230.www2.hp.com/sc/solutions/index.jsp to explore how the products in the HP
Software catalog work together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library athttps://hpln.hp.com/group/best-practices-hpsw to access a wide variety of best
practice documents and materials.

User Guide

HP UFT Connection Agent (For UFT 12.02) Page 3

https://softwaresupport.hp.com/
https://softwaresupport.hp.com/web/softwaresupport/access-levels
https://h20230.www2.hp.com/sc/solutions/index.jsp
https://hpln.hp.com/group/best-practices-hpsw


UFT Connection Agent Overview
This section includes:

l "What is the UFT Connection Agent?" below

l "What happens when UFT activates the Remote Object Spy?" below

l "What Do I Need to Do to Upgrade from UFT 12.00" on the next page

l "What Do I Need to Configure on the Mac so UFT Can Test Web Applications?" on the
next page

l "How Do I Secure the Communication Between UFT and the Mac Computer" on
page 6

What is the UFT Connection Agent?
The UFT Connection Agent is a service installed on your Apple Mac computer, which
enables UFT to communicate with the Safari browser using the WebSockets protocol.
This enables UFT to run tests on Web applications running in Safari on the Mac and to
spy on objects in these applications.

When you install the UFT Connection Agent, the agent service is installed on your Mac,
and the Unified Functional Testing Agent extension is installed on the Apple Safari
browser.

The UFT Connection Agent runs automatically after installation and after each restart
of the Mac and communicates with UFT on the one hand and the Unified Functional
Testing Agent Safari extension on the other.

What happens when UFT activates the Remote Object Spy?
When UFT initiates a Spy session (using the Remote Object Spy), the mouse on the Mac
computer can be used only for spying on Web objects in Safari.

HP UFT Connection Agent (For UFT 12.02) Page 4



The Unified Functional Testing Agent extension icon in the Safari toolbar changes

to a UFT Spy button , which you can use to suspend and then resume the Spy
session.

For more details on using UFT to spy on Web objects in Safari, see the section on the
Remote Object Spy in the HP Unified Functional Testing User Guide.

What Do I Need to Do to Upgrade from UFT 12.00
If you previously used UFT 12.00 to test Web applications on Safari, then after you
upgrade UFT you must reinstall the UFT Connection Agent on the Mac from the current
UFT version.

The UFT Connection Agent preferences and the Unified Functional Testing Agent Safari
extension preferences are reset to their defaults.

If you want to use non-default preferences, for example, if you configured UFT to use a
port other than the default 8822 for remote connections, then you must reconfigure
these preferences on the Mac computer.

This is required because of significant changes in the UFT Connection Agent's
preferences. For example, the UFT Connection Agent now uses different ports to
communicate with UFT and the Safari extension. In UFT 12.00, the same port was used
for both communications.

What Do I Need to Configure on the Mac so UFT Can Test Web
Applications?
By default, you do not need to modify the preferences set for the UFT Connection Agent
and the Unified Functional Testing Agent extension.

l UFT and the connection agent communicate using port 8822

l The connection agent and the UFT Safari extension communicate using port 8823.
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However, in some situations, you might want to specify different ports. For example:

l If another application on the Mac uses these ports.

l If multiple UFT users need to connect to the same Mac computer. Each UFT user can
use a connection agent installed under a different Mac user account, with a different
port number configured.

Caution: If you modify the port numbers, make sure that:

l The UFT port defined in the UFT Connection Agent preferences matches the one
defined in UFT.

For details on setting this in UFT, see the topic on connecting to a remote Mac
computer in the Web Add-in Quick Reference section of the HP Unified Functional
Testing Add-ins Guide.

l The Safari port defined in the UFT Connection Agent preferences matches the
one defined in the Unified Functional Testing Agent extension in Safari.

In addition to the port numbers, you can configure the level of log messages to collect.
By default, log messages are collected from the connection agent, but not the Safari
extension.

How Do I Secure the Communication Between UFT and the Mac
Computer
When UFT communicates with the Mac, UFT acts as a client and the UFT Connection
Agent acts as a server.

You can secure this communication on different levels:

1. You can set up client authentication by defining a passphrase for UFT to use when
contacting the Mac.

2. You can secure the communication between UFT and the UFT Connection Agent by
requiring that they use an SSL connection.
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For more details, see the topic on securing the communication with the remote Mac
computer in the Web section of the HP Unified Functional Testing Add-ins Guide

For task details on configuring the UFT Connection Agent preferences, the Unified
Functional Testing Agent Safari extension preferences, and the security settings, see
"Configure the UFT Connection Agent Preferences (Optional)" on page 9.
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Installation, Configuration, and
TroubleShooting
The UFT Connection Agent is a service installed on your Apple Mac computer, which
enables UFT to communicate with the Safari browser using the WebSockets protocol.
This enables UFT to run tests on Web applications running in Safari on the Mac and to
spy on objects in these applications. For details, see "UFT Connection Agent Overview"
on page 4.

This task describes installing and configuring the UFT Connection Agent, and includes
the following steps:

l "Install or Uninstall the UFT Connection Agent" below

l "Configure the UFT Connection Agent Preferences (Optional)" on the next page

l "Configure the Unified Functional Testing Agent Extension in Safari (Optional)" on
page 11

l "Troubleshooting the UFT Connection Agent" on page 12

Install or Uninstall the UFT Connection Agent

l You must have administrator permissions to install the UFT Connection Agent.

l All Mac users that use the UFT Connection Agent must have the agent installed in
their Mac user account.

1. Copy the installer image file (UFTConnectionAgent.dmg) from the
<UFT installation folder>/Installations/Safari folder to the Mac.

2. Open the UFTConnectionAgent.dmg image file.

3. Double-click (HP UFT Connection Agent.pkg) to start the installation wizard, or
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Uninstall to remove the agent from your Mac.

This installs or removes both the UFT Connection Agent and the Unified Functional
Testing Agent Safari extension.

Note: If Safari or the System Preferences pane are open when you uninstall the
agent, reopen them for the uninstallation to take effect.

Configure the UFT Connection Agent Preferences (Optional)

1. To check or modify the status of the UFT Connection Agent, or to update its
preferences, open System Preferences and double-click HP UFT Connection Agent.

2. You can modify any of the following preferences (separately for each Mac user):

n Connection Port Numbers

o Safari port. The port on which the UFT Connection Agent communicates with
the Unified Functional Testing Agent Safari extension. (Default: 8823)

This number must match the Remote Agent Port number defined in the
Unified Functional Testing Agent extension in Safari.

o UFT port. The port on which UFT communicates with the UFT Connection
Agent. (Default: 8822)

This number must match the number defined in UFT for initiating the remote
connection to the Mac.

n Security Configuration

o Passphrase. The passphrase that UFT must use for authentication when
initiating a remote connection to the Mac computer.

This string must match the passphrase defined in UFT's Remote Connection
pane in the Options dialog box (Tools > Options > GUI Testing > Remote
Connection).
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The passphrase can be empty, but a long and complicated passphrase that is
difficult to guess provides better security.

o Use SSL. Indicates that UFT must use SSL when initiating the connection to
the Mac computer.

If you select this option, then:

l The Use SSL option, available in UFT when initiating a remote connection,
must also be selected.

l You must specify the paths to the SSL certificate file to use for the
communication and its SSL private key.

These files must be accessible to the UFT Connection Agent when it sets up
the connection. (Chain certificate files are also supported)

l In UFT (Tools > Options > GUI Testing > Remote Connection), specify the
CA certificate that UFT can use to validate the SSL certificate file when
received from the UFT Connection Agent.

For more details, see the topic on securing the communication with the remote
Mac computer in the Web section of the HP Unified Functional Testing Add-ins
Guide.

n Log Messages Configuration

o Log folder. The folder in which to save activity log messages.

Make sure you have write permissions for this folder.

o Agent log level. The level of information to save in the agent log (Fatal,
Error, Warning, Debug).

The log is saved in the UFTAgent.log file in the specified folder.

o UFT Safari extension logs. Specifies whether to maintain a log of the Unified
Functional Testing Agent Safari extension activity in addition to the
UFT Connection Agent log. (Default: OFF).
There is no need to turn these logs on, unless HP Support personnel request
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it.

This log is saved in the SafariLog.log file in the same folder.

Note: To activate the Unified Functional Testing Agent Safari extension
log, you must also select Enable Remote Logging in the extension's
preferences in Safari.

3. Make sure the Safari browser is closed and then click Apply & Save to save your
changes and restart the agent with the new preferences.

n The agent's status is displayed in the HP UFT Connection Agent preference pane.

Check the status to make sure the agent runs successfully with the new
preferences. If it does not, check the UFTAgent.log file for problem details.

n If you set the UFT Safari extension logs option to ON and the remote logger
service that logs the Safari extension activity fails to run, this option is
automatically set back to OFF. Check the SafariLog.log file for problem details.

Configure the Unified Functional Testing Agent Extension in Safari
(Optional)

1. Open the Unified Functional Testing Agent extension in Safari.

a. Select Safari > Preferences

b. In the Preferences dialog box, select the Extensions tab.

c. In the Extensions list in the left pane of the dialog box, select the Unified
Functional Testing Agent extension.

2. In the right pane, you can modify any of the following preferences:

n Remote Agent Port: The port number on which the UFT Connection Agent
communicates with the Safari browser. (Default: 8823)
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Caution: This number must match the Safari port number defined in the
UFT Connection Agent preferences.

n Show Object Spy popover when Spy starts: If you turned off the notification
displayed on Safari when UFT initiates a Spy session, you can turn it back on
using this option.

n Options related to maintaining a log of the Unified Functional Testing Agent
Safari extension activity.There is no need to modify these options, unless HP
Support personnel request it.

o Default Logging Level. The level of information to save in the Unified
Functional Testing Agent Safari extension log file. (All, Trace, Debug, Info,
Warn, Error, Fatal, Off )

o Enable Remote Logging. Specifies whether to maintain a log of the Unified
Functional Testing Agent Safari extension activity in addition to the
UFT Connection Agent log. (By default, this option is cleared.)

This log is saved in the SafariLog.log file in the same folder as the
UFT Connection Agent logs.

Note: To activate the Unified Functional Testing Agent Safari extension
log, you must also select UFT Safari Extension logs in the
UFT Connection Agent preferences.

o Leave the Logging Exceptions box empty. This is intended for use by
HP Support only.

Troubleshooting the UFT Connection Agent

l If the agent remains in not running status after you update its preferences, check
the UFTAgent.log file for problem details.
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For example, the ports you specified might be busy. They may be used by another
application, or they may be in use by a UFT Connection Agent installed on the Mac
under another user's account.

Alternatively, you might have entered a port number that is restricted by Apple.
Consult the Apple support site regarding restricted or blocked ports.

l If UFT fails to connect to the Mac, make sure that the security settings defined in
UFT match those defined in the UFT Connection Agent. For more details, see the
topic on securing the communication with the remote Mac computer in the Web
section of the HP Unified Functional Testing Add-ins Guide.

l If UFT fails to run tests on Safari or to recognize that it is installed on the Mac:

n Make sure that Safari port number defined in the UFT Connection Agent
preferences, matches the Remote Agent Port number defined in the Unified
Functional Testing Agent extension.

Make sure that the UFT port number defined in the UFT Connection Agent
preferences, matches the number defined in UFT for initiating the remote
connection to the Mac.

n Make sure that you are not using a port number that is blocked by Safari. Consult
the Apple support site regarding restricted or blocked ports.

l If you manually remove the Unified Functional Testing Agent extension from Safari,
or the HP UFT Connection Agent preferences pane from the System Preferences, you
can reinstall them by reinstalling the UFT Connection Agent on the Mac.

Reinstalling the UFT Connection Agent resets its preferences to their defaults. Make
sure to update the preferences, if necessary, so that the correct port numbers are
defined in the agent preferences and in the Safari extension.

l If you turn on the UFT Safari extension logs, and when you save the preferences, the
log option is set to OFF, check the SafariLog.log file for problem details.

For example, the port used for these logs is the Safari port + 1. If this port is busy,
the remote logger service fails.
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Send Us Feedback
Can we make this User Guide better?

Tell us how: sw-doc@hp.com
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